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TermSecure 

 

TermSecure Overview 
TermSecure is a ThinManager feature that allows users to logon to a ThinManager Ready thin client and 
access user-specific or terminal-specific Display Clients. This does not replace the Windows logon, but adds 
an additional layer of security and control.  

TermSecure has two main strategies: 

 SecureAccess or Terminal-specific Applications: You can assign a display client 
to a terminal and keep it hidden from operators with Permissions. A user with the 
proper TermSecure credentials will be able to reveal and access the hidden 
application. 
 
An example would be a recipe program that would allow a supervisor to initiate a 
product change. This belongs to the station on the floor but you want to prevent 
users from initiating the change. 

 SmartContext or User-specific Applications: You can assign Display Clients to a 
TermSecure user and they can get access to it from any terminal in the plant. This 
can be initiated by either manual login or the use of an authentication device.   
This allows a user to leave one terminal, logon to a different terminal, and reconnect 
to their session, essentially having the session follow him from terminal to terminal. 
 
An example would assign a session with reports to a quality control worker who 
could login anywhere and retrieve their reports. 

SecureAccess or Terminal-specific Applications are controlled with Permissions. 

SmartContext or User-specific Applications are controlled by adding the Display Client to the TermSecure 
User configuration. 

Note: TermSecure requires the usage of Display Clients instead of using individual terminal servers.  

Five licenses of TermSecure are included with each Master License activation. Additional TermSecure 
licenses can be purchased to add to the Master License. 



 

442    TermSecure Automation Control Products ThinManager 4.1 Help Manual 

Users Types 
There are three types of users in a ThinManager system. Windows Users and TermSecure Users are 
important to TermSecure. 

Windows Users 
Windows Users are the Microsoft accounts created in Windows that allow access to the Windows terminal 
servers. These are configured within Windows and authenticated by Windows. They can be given varying 
levels of access and power using Windows User Groups and Group Policies. 

TermSecure Users 
TermSecure Users are users who can go to a ThinManager Ready thin client and receive access to specific 
Display Clients due to their membership in a TermSecure Access Group. The login and authentication is done 
by ThinManager a level above the Windows login.  

TermSecure grants and limits access to terminals and Display Clients but a Windows User login is still 
required to actually logon to the terminal server. 

ThinManager Security Group Users 
ThinManager Security Group Users are Windows User Group members who have been configured in the 
ThinManager Server Configuration Wizard to have varying levels of access and control within the 
ThinManager program. 

These groups are configured on the ThinManager Security Groups page of the ThinManager Server 
Configuration wizard. See ThinManager Security Groups for details. 

Deploying TermSecure 
TermSecure may require a number of steps to configure and deploy TermSecure: 

1. TermSecure Access Groups can to be created to use Permissions (optional). 
See Creating Permissions Groups for details. 

2. Terminals can be assigned TermSecure Access Groups to limit access to specific users (optional). 
See Permission Groups for Terminals for details. 

3. Display Clients can be assigned TermSecure Access Groups to limit access to specific users 
(optional). 
See Permission Groups for Display Clients for details. 

4. TermSecure Users need to be created. 

5.  TermSecure Users can be assigned to TermSecure Access Groups (optional).  
See TermSecure User Configuration Wizard for details. 

6. A Login strategy needs to be put in place. The TermSecure User can use the Terminal Login, their 
TermSecure login, or a Windows login to access the terminal servers.  
See Windows Login Information for details. 

7. USB drives and ProxCards, if used, need to have the identification number entered in their 
configuration (optional).  
See Card/Badge Information for details. 

8. The TermSecure User can then login to a ThinManager Ready thin client using TermSecure  
TermSecure prompts the TermSecure User to login to the terminal servers using a Windows User 



 

Automation Control Products ThinManager 4.1 Help Manual Permissions    443 

account, or it will pass the pre-configured Windows User account information to the terminal server 
for auto-login, based on the login strategy selected.  

9. The TermSecure User is granted access to all Display Clients that share the same TermSecure 
Access as the TermSecure User, and is denied access to Display Clients that they don’t share a 
TermSecure Access Group membership.  

Permissions 

Permissions restrict access to applications unless a person has been given a TermSecure login and the 
matching permission set. 

Creating Permissions Groups 
Permissions grant or limit access through the TermSecure Access Groups. Select the Permissions button in 
the Terminal Configuration Wizard, the Terminal Group Configuration Wizard, the Display Client 
Wizard, the TermSecure User Wizard, or the TermSecure Users Group Wizard to set these up. 

 Terminal Permissions is the list of named permission groups whose members may 
access a terminal. The Unrestricted group does not require a membership to access.  

 Terminal Group Permissions is the list of named permission groups whose members 
may access a terminal belonging to the Terminal group. The Unrestricted group does 
not require membership to access.  

 Display Client Permissions is a list of named permission groups whose members may 
access and view a Display Client. The Unrestricted group does not require a login. 

 TermSecure User Permissions is a list of named permission groups to which a 
TermSecure User belongs.  

 TermSecure User Group Permissions is a list of named permission groups to which 
members of a TermSecure User Group belong.  

A TermSecure User can use a terminal when they share membership in a TermSecure Access 
Group. 

A TermSecure User can use a Display Client when they share membership in a TermSecure 
Access Group. 
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Creating a TermSecure Access Group  

Selecting Manage > TermSecure Access Groups from the ThinManager menu will launch the Access 
Groups window. 

 

Access Groups Window with Default Groups 

Select the Add button to add an Access Group. The Add button launches an Access Group window. 

 

Permission Group Creation Window 

Enter a name for the new TermSecure Access Group and select OK to create the group. 
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Additional TermSecure Access Groups Created 

The created Access Groups will be displayed in the Access Group window. These TermSecure Access 
Groups, like Microsoft User Groups, do not have settings and parameters, but instead get their usefulness by 
adding members to them or applying restrictions to them. 
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Permission Groups for Terminals 
TermSecure Access Groups are assigned to a terminal with the Permissions button on the first page of the 
Terminal Configuration Wizard. 

Note: Removing the Unrestricted group from a terminal and replacing it with a TermSecure Access group will 
render the terminal functionless until a member of the group logs in. 

Open the Terminal Configuration Wizard for an existing terminal by double clicking on it in the tree. Start the 
Terminal Configuration Wizard for a new terminal by selecting Edit > Add Terminal. 

 

Terminal Configuration Wizard 

Select the Permissions button on the first page of the Terminal Configuration Wizard to launch the 
Permissions window to apply the TermSecure Access Groups to the terminal. 
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 Permissions Window 

By default, the terminal uses the Unrestricted access group, allowing anyone access to the Display Clients 
that are assigned to the terminal. 

If Additional Permission Groups are configured, they will be displayed in the Available list. Access can be 
granted or denied by moving the Access Groups into or out of the Member Of list by double clicking or 
highlighting the desired group and selecting an arrow. 

 

Object Permissions 

If the terminal has the Unrestricted access group removed from Member Of list and is replaced by other 
Access Groups, TermSecure will deny access to the terminal except for members of the selected access 
groups. 

Note: Removing the Unrestricted group from a terminal and adding a different group will render the terminal 
functionless until a member of the group logs in. 

Select OK to close the Permissions window. 
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Permission Groups for Display Clients 
TermSecure Access Groups are assigned to a Display Client with the Permissions button on the first page of 
the Display Client Wizard. 

Open the Display Client Wizard for an existing Display Client by double clicking on it in the tree. Start the 
Display Client Configuration Wizard for a new Display Client by right clicking on the Display Client branch icon 
and selecting Add Display Client. 

 

Display Client Configuration Wizard 

Select the Permissions button on the first page of the Display Client Configuration Wizard to launch the 
Permissions window to apply the TermSecure Access Group to the Display Client. 
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 Permissions 

By default, the Display Client uses the Unrestricted access group, allowing anyone access to the Terminal 
Server. 

If Additional Permission Groups are configured, they will be displayed in the Available list. Access can be 
granted or denied by moving the Access Groups into or out of the Member Of list by double clicking or 
highlighting the desired group and selecting an arrow. 

 

Permissions Changed 

If the Display Client has the Unrestricted access group removed from Member Of list and is replaced by 
other Access Groups, TermSecure will deny access to the terminal except for members of the selected 
access groups. 

Note: Removing the Unrestricted group from a terminal and adding a different group will hide the Display 
Client until a member of the group logs in. 

Select OK to close the Permissions window. 
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Permission Groups for TermSecure Users 
TermSecure Access Group permissions can be applied to TermSecure Users. This is useful for 
SecureAccess or Terminal-specific Applications. 

Create a TermSecure User to apply the permissions by right clicking on the TermSecure User branch of the 
ThinManager tree and selecting Add TermSecure User.  

TermSecure Access Groups are configured on the first page of the wizard by selecting the Permissions 
button. 

TermSecure User Information 

 

TermSecure User Information 

Selecting the Permissions button will open the Permissions window that allows the assignment of a 
TermSecure Access Groups. 
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 Permissions 

The Permissions window for TermSecure Users does not show the Unrestricted or the All Users groups, 
just the created groups. Access can be granted or denied by moving the Access Groups into or out of the 
Member Of list by double clicking or highlighting the desired group and selecting an arrow. 

Select OK to close the Permissions window. 

Select Next to continue with the TermSecure User Configuration Wizard. 

Card / Badge Information 

The second page of the TermSecure User Configuration Wizard is the Card/Badge Information page. 
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Card / Badge Information Page 

The Card / Badge Information Page enables the use of Identification devices such as USB flash drives, HID 
ProxCards, and WaveTrend Radio Frequency IDs (RFIDs) as login devices. This will be covered later. See 
Card and Badge Configuration for a TermSecure User for details 

Note: Terminals using the USB flash drives, HID ProxCards, and WaveTrend RFIDs, as login devices will 
need the appropriate module added. See TermSecure Modules for details. 

Select the Next button to continue with the configuration. 
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Display Client Selection 

The next page of the TermSecure User Configuration Wizard is the Display Client Selection page. 

 

Display Client Selection 

The Display Client Selection page allows Display Clients to be assigned to the TermSecure User. 

Add User specific Display Clients? - This setting, if set to No, will allow the TermSecure User to access the 
display client hidden on a terminal with the TermSecure Access Group permissions. This is used with 
SecureAccess or Terminal-specific Applications. 

This setting, if set to Yes, will allow the selection of Display Clients for the TermSecure User that will be 
added to the terminal when the TermSecure User logs in top the terminal. This is used with SmartContext or 
User-specific Applications. 

Select the Next button to continue with the configuration. 
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Terminal Interface Options 

The next page of the TermSecure User Configuration Wizard is the Terminal Interface Options page. 

 

Terminal Interface Options 

The Terminal Interface Options page sets the menus and hotkeys for the TermSecure User so a terminal 
using MultiSession will need to have a method to switch between sessions.  

See Terminal Interface Options for details. 
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Terminal Hotkey Options 

The next page of the TermSecure User Configuration Wizard is the Terminal Hotkey Options page. 

 

Terminal Hotkey Options 

Terminal Hotkeys on the Hotkey Configuration page allows the selection of keyboard combinations that 
allow switching between sessions. 

See Terminal Hotkeys for details. 
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User Options 

The final page of the TermSecure User Configuration Wizard is the User Options page. 

 

User Options 

See User Options for details. 

Select Finish to finish the configuration. 
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Shortcut Method of Adding TermSecure Access Groups 
Members can be added to TermSecure Access Groups quickly through the TermSecure Access Group 
Wizard. 

Open the TermSecure Access Group Wizard by selecting Manage > TermSecure Access Groups from the 
ThinManager menu. This will launch the Access Groups window. 

 

Access Groups Window 

Highlight the desired TermSecure Access Group and select the Edit button. 

 

Access Group Window 
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Select the Edit Members button to launch the Access Group Members window. 

 

Access Group Members Window 

Select the Terminals, Display Clients, or TermSecure Users radio button to configure that category and 
select the Add button. 

 

Select Terminal Window 

A Select Terminal window will be displayed with a tree of the configured terminals and terminal groups. 
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Select the desired terminals and terminal groups and select OK for each addition. 

 

Access Group Members 

The Access Group Members window will show the members of the TermSecure Access Group. These can be 
removed by highlighting and selecting the Remove button. 

Display Clients and TermSecure Users can be added by the same process of adding by selecting the 
appropriate radio button. 

 

Display Client Selection 
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Member Display Clients  

Members can be removed by highlighting them and selecting the Remove button. 
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TermSecure User Configuration Wizard 
A TermSecure User can be configured with a user name, password, and user-specific Display Clients. When 
the user logs into a terminal with that identity, TermSecure will allow the user access to the personalized 
Display Clients for that user in addition to the Display Clients already assigned to the terminal. 

Note: The TermSecure Users branch of the ThinManager tree will not be visible unless a Master License is 
installed on the ThinManager Server. 

The TermSecure User Configuration Wizard is launched by right clicking on the TermSecure Users branch 
of the ThinManager tree and select Add TermSecure User.  

TermSecure User Information 

The first page of the TermSecure User Configuration Wizard is the TermSecure User Information page. 

 

ThinManager User Information 

The TermSecure User Information has fields for the user name and password that will be used by the 
TermSecure User to log into ThinManager security to access TermSecure functions.  

The TermSecure User Information is for account information: 
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 User Name - Enter the user name that the user will use to log into the TermSecure system. Although 

this can be the same as the Windows user name, the TermSecure user name is independent of the 

Microsoft Windows login. This TermSecure user name can be tied to a Windows login later in the 

wizard on the Windows Login Page.  

 Password - Enter the password for the TermSecure User in this field. 

 Verify Password - Re- enter the password for the ThinManager User in this field.  

 The Password Options button launches the Password Maintenance Options window that 

regulates rules for the ThinManager User password. 

 

Password Maintenance Options 

Password Complexity Requirements: 

 Minimum Password Length - Sets the amount of characters that the password must contain to be 
valid. 

 Must contain numbers - This checkbox, if checked, will require that the password contain at least 
one number in it. 

 Must contain symbols - This checkbox, if checked, will require that the password contain at least 
one symbol in it. 

 Must contain capital letters - This checkbox, if checked, will require that the password contain at 
least one capital letter in it. 

Password Maintenance: 
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 Allow User to change password - This checkbox, if checked, will allow the user to change the 
password at the TermSecure menu. 

 Force User to change password at next login - This checkbox, if checked, will require the user to 
change the password at the TermSecure menu when they login the next time. 

 Force User to change password periodically - This checkbox, if checked, will require the user to 
change the password at the TermSecure menu on the schedule set by the User must change 
password every X days field. 

 User must change password every X days - This field sets the time period between the scheduled 
password changes caused by the Force User to change password periodically checkbox. 

The OK button closes the window with any changes. The Cancel button closes the window without changes. 

Group: 

 The Change Group button opens the Choose User Group window that allows a User to be placed 
in an existing TermSecure Users Group. 

 

Choose User Group 

If TermSecure User Groups have been created, the Choose User Group window will display the 
TermSecure User Group branch of the ThinManager tree. 

 To add the TermSecure User to a TermSecure Users Group, highlight the desired TermSecure Users 
Group and select the OK button. 

 To change the TermSecure User to a different TermSecure Users Group, highlight the desired 
TermSecure Users Group and select the OK button. 

 To remove the TermSecure User from all TermSecure Users Groups, highlight the top-level Users 
branch and select the OK button. 

The OK button closes the window with any changes. The Cancel button closes the window without changes. 

Copy Settings: 
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 The Copy Settings from another User checkbox, if selected, activates the Copy From button that 
allows the configuration of an existing TermSecure User to be applied to the current TermSecure 
User. 

 The Copy From button opens the Select User window that allows the selection of the desired 
TermSecure User configuration. 

 

Select User Window 

The Select User window will show a tree with the existing TermSecure User Groups and the TermSecure 
Users.  

Highlight the TermSecure User whose configuration you want to copy and select the OK button. The OK 
button closes the window with any changes. The Cancel button closes the window without changes. 
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Card / Badge Information 

The next page of the TermSecure User Configuration Wizard is the Card/Badge Information page. 

 

Card / Badge Information Page 

The Card / Badge Information Page enables the use of Identification devices such as USB flash drives, HID 
ProxCards, and WaveTrend Radio Frequency IDs (RFIDs) as login devices. This will be covered later. See 
Card and Badge Configuration for a TermSecure User for details 

Note: Terminals using the USB flash drives, HID ProxCards, and WaveTrend RFIDs, as login devices will 
need the appropriate module added. See TermSecure Modules for details. 

Select the Next button to continue with the configuration. 
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Display Client Selection 

The next page of the TermSecure User Configuration Wizard is the Display Client Selection page. 

 

Display Client Selection 

The Display Client Selection page allows Display Clients to be assigned to the TermSecure User. When the 
TermSecure User logs onto a terminal, these Display Clients will be available on the terminal for him. 

Add User specific Display Clients? - This setting, if set to Yes, will allow the selection of Display Clients for 
the TermSecure User that will be added to the terminal when the TermSecure User logs in top the terminal. 
This provides the user-specific Display Clients. 

This setting, if set to No, will rely on Permissions to grant access to terminal-specific Display Clients. 

Select the Next button to continue with the configuration. 
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Display Client Specification 

The next page of the TermSecure User Configuration Wizard is the Display Client Specification page. 

 

Display Client Specification Page 

The Display Client Specification page allows Display Clients to be assigned to the TermSecure User if the 
Add User specific Display Clients? radio button is set to Yes. 

Move a Display Client you want the TermSecure User to use into the Selected Display Clients list by 
double-clicking on it in the Available Display Clients list or by highlighting it and clicking the Right Arrow 
button. 

To add a new Display Client, select the Edit Display Clients button to launch the Display Client Wizard. See 
Display Client List for details. 

Select the Next button to continue with the configuration. 
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Windows Login Information 

The next page of the TermSecure User Configuration Wizard is the Windows Log In Information page. 

 

Windows Login Information 

The Windows Log In Information page allows the configuration of how the TermSecure User will log on to 
the Windows terminal servers. 

There are several Windows login options for the TermSecure User. 

1. The TermSecure User can use the terminal’s username and password to auto-log on to the terminal 
server. To do this, check the Use Terminal Configuration Login Information checkbox 

2. The TermSecure User can use the TermSecure User username and password to auto-log on to the 
terminal server. To do this, check the Same as TermSecure User username/password checkbox. 
The TermSecure User username and password must match a Windows User username and 
password to get authenticated by Windows. 

3. The TermSecure User can use a separate username and password to auto-log on to the terminal 
server. To do this, use the fields for the Username, Password, and Domain that are provided. 

4. The TermSecure User can be required to manually log onto the terminal servers. To do this, leave the 
checkboxes unchecked and the Username, Password, and Domain empty. 

Select the Next button to continue with the configuration. 
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Terminal Interface Options 

The next page of the TermSecure User Configuration Wizard is the Terminal Interface Options page. 

 

Terminal Interface Options 

The Terminal Interface Options page sets the menus and hotkeys for the TermSecure User so a terminal 
using MultiSession will need to have a method to switch between sessions.  

Group Selector Options allow on-screen switching of sessions. 

Use Terminal Settings - This checkbox, when selected, will let the TermSecure User inherit the properties 
that were configured for use with the terminal. 

 Show Group Selector on Terminal - This checkbox, if selected, will display an on-screen drop-down 
menu that can be activated by mouse.  

 Enable Tiling - This checkbox, if selected, allows the sessions to be tiled so that the user can make a 
visual selection of the desired selection. 

 Screen Edge Group Selection - This checkbox, if selected, will activate a feature that will switch 
windows if the mouse is moved off screen. 

 Selector Options - This button, if selected, will launch the Group Selector Options window. 

 Tiling Options - This button, if selected, will launch the Tile Options window. 
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Group Selector Options Window 

The Group Selector Options window has several settings. 

 The Auto-hide Group Selector checkbox will hide the Group Selector until the mouse is moved to 
that space. 

 The Tile on Group Selector checkbox, when selected, will tile the Display Clients when the auto-hid 
selector is chosen. This allows the user to select from the available sessions. 

Select the OK button to accept changes or the Cancel button to close. 

The Tiling Options button will launch the Group Selector Options window that allows configuration of the 
on-screen Group Selector bar. 

 

Tile Options 

The Tile Options window has several settings. 

 Show Grid – This checkbox, when selected, will show the tiled sessions in a grid with each grid 
labeled with the session name as while the session is loading. 

 Tile Inactivity Time – This field sets the length of time that the terminal screen will stay focused on a 
selected session before reverting back to a tiled state due to inactivity.  

 Tile Display Clients at startup – This checkbox, when selected, will show the sessions tiled when 
the terminal first connects to its sessions. 

 Include Main Menu as tile – This checkbox, when selected, will include a session displaying the 
TermSecure Main Menu. 

 Tile on Right click (mouse or touchscreen) - This checkbox, when selected, will initiate tiling when 
a session is right clicked. 

 Tile Interactive – This checkbox, when selected, will allow a user to click into a tiled session and 
control it interactively without switching focus to a single session. To focus on a single session use 
the Group Selector Dropdown or the tiling hotkey (CTL + T), if enabled. 

Select the OK button to accept changes or the Cancel button to close. 

The Main Menu Options button will launch the Main Menu Options window that allows configuration of the 
TermSecure Main Menu. 
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Main Menu Options Window 

The Allow Reboot/Restart checkbox, if selected, will add a Reboot and Restart button to the main menu. 

Terminal Hotkey Options 

The next page of the TermSecure User Configuration Wizard is the Terminal Hotkey Options page. 

 

Terminal Hotkey Options 

Terminal Hotkeys on the Hotkey Configuration page allows the selection of keyboard combinations that 
allow switching between sessions. 

Use Terminal Settings - This checkbox, when selected, will let the TermSecure User inherit the properties 
that were configured for use with the terminal. 



 

472    Permissions Automation Control Products ThinManager 4.1 Help Manual 

 Enable Instant Failover Hotkeys - This checkbox, if selected, allows the hot key switching between 
the two active sessions of a Display Client that is using Instant Failover. 

 Enable Group Hotkeys - This checkbox, if selected, allows the hot key switching between different 
sessions of a terminal using MultiSession. 

 Enable Tiling Hotkey – This checkbox, if selected, allows SessionTiling to be activated by a hotkey 
combination. 

Selecting the Change Hotkeys button when Enable Instant Failover Hotkeys is selected will allow the 
hotkeys to be changed from the default. 

 

Select Instant Failover Hotkeys  

The default hotkey for Instant Failover switching is set to Control+F9. This can be changed by selecting the 
Alt Key radio button or using the drop-down to select another function key. 

Selecting the Change Hotkeys button when Enable Group Hotkeys is selected will allow the MultiSession 
switching hotkeys to be changed from the default. 
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Select MultiSession Switching Hotkeys 

The default hotkey for MultiSession switching is set to Control+Page Up and Control+Page Down. This can 
be changed by selecting the Alt Key radio button or using the drop-down to select another hot key. 

Selecting the Change Hotkeys button when Enable Tiling Hotkeys is selected will allow the hotkeys to be 
changed from the default. 

 

Select SessionTiling Hotkeys 

The default hotkey for SessionTiling activation is set to Control+t. This can be changed by selecting the Alt 
Key radio button or using the drop-down to select another hot key. 

Select the OK button to continue or the Cancel button to close without accepting changes. 
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User Options 

The final page of the TermSecure User Configuration Wizard is the User Options page. 

 

User Options 

Log In / Log Out Options 

 Inactivity Timeout - TermSecure will log a TermSecure Users off the terminal after this much 
inactive time has passed.  

 Reset Sessions at Logout - This checkbox, if selected, will logoff a session when the TermSecure 
User logs off. 

 Activate User Group at Log In - This checkbox, if selected, will display the TermSecure User’s first 
Display Client when the user logs in to the terminal. 

User Schedule 

 Set Schedule - 

Selecting the Schedule button on the User Options page will launch the Event Schedule window and allow 
a schedule to be created for terminal events. 

See Terminal Schedule for details. 

Terminal Effects 
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 Enable Terminal Effects - This allows the use of Terminal Effects. This currently includes sliding 
Windows and message rollups. 

Shadowing 

 Allow terminal to be shadowed - This drop-down box allows the configuration of Shadowing 
Options. 

o No - Prevents the TermSecure Users from being shadowed. 

o Ask - Will display a message window that will prompt for a positive response before the 
shadowing is allowed. 

o Warn - Will display a message window alerting the terminal that it is to be shadowed, but 
doesn’t require a positive response before the shadowing is allowed. 

o Yes - Allows shadowing to occur without warning or recipient input. 

 Allow Interactive Shadow - This checkbox, if selected, will allow members with Interactive Shadow 
privileges to shadow this TermSecure User. 

Shadowing is initiated from the Shadow tab on the Details pane of the ThinManager program. Unselecting 
this will prevent shadowing from within ThinManager. 

Select Finish to finish the configuration. 
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TermSecure Users Group Configuration Wizard 
TermSecure Users can be organized into TermSecure User Groups, just as Terminals can be organized into 
Terminal Groups. Each setting of the TermSecure Group has a Group Setting checkbox. If this box is 
selected then that setting will be applied to each member of the TermSecure Group. 

The TermSecure Users Group Configuration Wizard can be launched by right clicking on the TermSecure 
Users branch of the tree and selecting Add TermSecure User Group.  

TermSecure User Group Information 

The first page of the TermSecure Group Configuration Wizard is the TermSecure User Group 
Information page. 

 

ThinManager User Group Information 

The TermSecure User Group Information has fields for the group name and membership.  

 User Name - This field names the TermSecure User Group. 

Group Setting - This checkbox, if selected, applies this configuration to all members of the group. 

The rest of the TermSecure Group Configuration continues as the TermSecure User Configuration, with the 
addition of the Group Setting checkboxes. 
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TermSecure Group Configuration Wizard 

Group Settings that are selected will be grayed out for members of the group. Group Settings that aren’t 
selected will be available for configuration on the individual TermSecure User configuration page. 
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TermSecure Group Member 

Select Finish to complete the configuration. 
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Adding a TermSecure User to the TermSecure User 
Group 
To add a TermSecure User to a TermSecure User Group, create a new TermSecure User by right clicking on 
the TermSecure Users branch in the ThinManager tree and select the Add TermSecure User option or 
double click on an existing user to launch the wizard. 

 

TermSecure User Information Page 

Select the Change Group button. This will launch the Choose User Group window. 



 

480    Permissions Automation Control Products ThinManager 4.1 Help Manual 

 

Choose User Group Window 

Highlight your TermSecure Users Group and select OK. This will accept the changes and close the window. 
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TermSecure User Information Page 

The TermSecure User Group will now be displayed in the Group field. 

Select Next to continue. 
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Card/Badge Information 

The Card/Badge Information options are available because these are individual settings, not group settings. 

Select Next to continue. 
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Display Client Specification 

Each of the settings that have the Group Setting checkbox selected in the TermSecure User Group wizard 
will be grayed out because the Group Setting enforces the configuration of each chosen parameter. 

Select the Finish button to accept the configuration. 
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TermSecure Login 
To log in a TermSecure User on a terminal, go to a terminal that has the Enable TermSecure checkbox 
selected on the Terminal Server Specification page.  

Type the default CTL+m or other designated hotkey at the keyboard or select from group selector 

The Main Menu will be displayed on the terminal. 

 

TermSecure Main Menu 

The About button to see details about the terminal. 

 

About Menu 

Select OK to close the About window. 

Select the Log In button to login. 

 

TermSecure Log On Screen 

Enter your TermSecure User user name in the Enter User Name field. 

Select OK. 
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Password Screen 

Enter the password in the field. 

Select the OK button. If the user name and password are correct, ThinManager will allow the login. 

 

ThinManager With TermSecure Log On 

Once a TermSecure User is logged into a terminal, ThinManager will display the TermSecure User’s name 
after the terminal name in the tree.  

ThinManager will add the name of the terminal after the TermSecure User name in the tree. 

Right-clicking on a terminal and selecting Go to TermSecure User will move the focus to the TermSecure 
user that is logged into the terminal. 

Right-clicking on a TermSecure user and selecting Go to Terminal will move the focus to the terminal that 
the TermSecure user is logged into. 
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Logging Out 
The TermSecure User can be logged out by: 

 Opening the TermSecure Main Menu (type CTL+m) on the terminal and selecting the Log Off 
button. 

 Right clicking on the TermSecure User in the ThinManager tree and selecting Logoff User. 

 Restarting or Rebooting the terminal that has a TermSecure User logged in. 

 

Main Menu 

The Switch User button will log off the TermSecure User and open the Login screen for another TermSecure 
User. The Log Off button will log of the TermSecure User and return to the terminal’s display. 
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TermSecure Menu 
The TermSecure Menu that is displayed on a terminal that allows TermSecure Users to manually log on to a 
ThinManager Ready terminal is configurable for use with TermSecure. This menu is generated from the 
terminal and not the terminal server session.  

 

Basic TermSecure Menu 

The TermSecure Menu can be configured by a number of settings in the Terminal Configuration Wizard 
and TermSecure User Wizard. 

The Main Menu is activated on the Terminal Interface Options page of the Terminal Configuration Wizard 
and/or TermSecure User Configuration Wizard. 

Main Menu Configuration - Terminal Configuration Wizard 

Open the Terminal Configuration Wizard by double clicking on the desired terminal in the ThinManager 
tree. Terminals using Display Clients will display the Terminal Interface Options page. This page will display 
Main Menu options when TermSecure is enabled for the terminal. 
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Terminal Interface Options Page 

A terminal using MultiSession will need to have a method to switch between sessions. This is configured on 
the Terminal Interface Options page. For terminals using TermSecure, additional Main Menu options are 
available, as shown. See Terminal Interface Options for a terminal for a comparison. 

Group Selector Options allow on-screen switching of sessions. 

 Show Group Selector on Terminal - This checkbox, if selected, will display an on-screen drop-down 
menu that can be activated by mouse.  

 

On-Screen Group Selector 

 Screen Edge Group Selection - This checkbox, if selected, will activate a feature that will switch 
windows if the mouse is moved off screen. 
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 Selector Options button will launch the Group Selector Options window that allows configuration of 
the on-screen Group Selector. 

 

Group Selector Options Window 

The Auto-hide Group Selector checkbox, if selected, will hide the Group Selector until the mouse is 
move to that space. 

The Tile on Group Selector activation checkbox, when selected, will tile the Display Clients when 
the auto-hid selector is chosen. This allows the user to select from the available sessions. 

The Group Selector Menu Size drop-down box allows the setting of the size of the Group Selector 
font.  

Main Menu Options allow on-screen switching of sessions. 

 Show Main Menu on Group Selector - This checkbox, if selected, will display the TermSecure Main 
Menu as an option on the Group Selector drop-down. 

 The Main Menu Options button will launch a window for Main 
Menu settings. 

 

Main Menu Options 

The Main Menu Options window has several settings. 

 Allow reboot/restart – This checkbox, if selected, will add a Reboot and a Restart button on the 
main TermSecure login window. 

 Show Virtual Keyboard – This checkbox, if selected, will prompt the display of a virtual keyboard for 
TermSecure logins. This is helpful for thin clients with touch screens. 

The Allow reboot/restart checkbox, if selected, will add a Shut Down button to the TermSecure Main Menu. 
The Shut Down button leads to a menu with a Restart and Reboot button. 

 

Main Menu with Shut Down Button 



 

490    Permissions Automation Control Products ThinManager 4.1 Help Manual 

Once the user logs out, a Shut Down button will appear on the Main Menu. Selecting the Shut Down button 
will launch the Shut Down Menu. 

 

Shut Down Menu 

The Shut Down window has two buttons. 
 Restart , when selected, will log off the TermSecure User, reload the configuration and load any 

changes. 

 Reboot, when selected, will log off the TermSecure User, power off the terminal and reload firmware 

and configuration. 

 

Terminal Virtual Keyboard 

If the Show Virtual Keyboard checkbox is selected a virtual keyboard will be displayed on the terminal. This 
is helpful for touch screen users. 

Select OK to save setting or Cancel to close without saving. 
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Main Menu Hotkey - Terminal Configuration Wizard 

The Hotkey Configuration page has an additional TermSecure setting when the Enable TermSecure 
checkbox is checked on the Terminal Server Specification page. 

 

Hotkey Configuration – TermSecure Enabled 

The Enable Main Menu Hotkey checkbox, when selected, will allow the TermSecure Main Menu to be 
launched with a hotkey combination. The Change Hotkey button allows the default CTL+m combination to be 
changed. 
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Select HotKeys Window for Main Menu 

The default hotkey for the Main Menu is set to Control+m. This can be changed by selecting the Alt Key 
radio button or using the drop-down to select another hot key. 

Select the OK button to continue or the Cancel button to close without accepting changes. 

 

Main Menu 

The Main Menu can be launched with the Ctrl+ m hotkey if the Enable Main Menu Hotkey checkbox is 
selected. 
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Card and Badge Configuration for a TermSecure User 
TermSecure allows the use of USB drives and RFID cards as login devices at terminals. This is configured on 
the Card/Badge Information page of the TermSecure User Configuration Wizard. The TermSecure 
Users Configuration Wizard can be launched by double clicking on a TermSecure User in the ThinManager 
tree or by right clicking on the TermSecure Users branch of the tree and selecting Add TermSecure User.  

  
Card / Badge Information Page 

 This user will use a card, badge, or other device to log in - This checkbox, if 
selected, enables the use of a USB device, card or badge to login to a terminal. 

 Enter Card/Badge ID number - This field is for the unique identification number of 
the ID device. This can be filled manually or automatically. See Automatic 
Card/Badge ID Number Entry and Manual Card/Badge ID Number Entry for 
instructions on the methods. 

 Always Prompt for Password - This checkbox, if selected, will require a password 
in addition to the ID device to login to a terminal as a TermSecure User. 

Automatic Card/Badge ID Number Entry 
ThinManager can be configured to automatically add the Card/Badge ID number. There are a few conditions 
that need met to allow this to happen.  
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 The Display “Create New User” dialog for unknown users check box on the Options 
page must be selected.  

 The terminal must use Display Clients. 

 The terminal needs the Enable TermSecure checkbox on the Terminal Specification 
page of the Terminal Configuration Wizard. 

 The USB Drive module, RF Ideas pcProx Module, or Wavetrend Tag Reader Module 
need added to the terminal. The USB Drive module needs the Use with TermSecure 
parameter set to Yes. 

 The user needs to scan the card or insert the USB drive to start the TermSecure 
Configuration Wizard. 

Automatic Card/Badge use starts with the enabling of the Create New User dialog box. This is configured on 
the Options window that is opened by selecting View > Options. 

 

Options Window 

The Display “Create New User” dialog for unknown users check box, if selected, will launch the 
TermSecure User Configuration Wizard on the ThinManager Server when an unknown ID device (USB key 
or ID card) is read by a terminal. Once this checkbox is selected, scanning a new ID card or inserting an 
undefined USB key will launch the TermSecure User Configuration Wizard with the Enter Card/Badge ID 
number automatically filled in. 
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TermSecure User Configuration – TermSecure User Replacement 

When a new card is scanned or a new USB key is inserted into a USB slot on the terminal the TermSecure 
User Configuration is launched with an option to assign the card to an existing user. 

Selecting Next will open the TermSecure User Configuration Wizard and allow a new TermSecure user to be 
configured. 

Selecting Assign Card Number to Existing User will launch the Select TermSecure User to replace 
window to assign the card/badge number to an existing TermSecure User account.  
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Select TermSecure User To Replace Window 

Highlight the desired TermSecure user and select OK. The wizard will display the TermSecure User 
Information page with the selected user entered. 
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TermSecure User Information Page 

If a TermSecure user was selected for the badge, the user will be displayed in the User Name field of the 
TermSecure User Information page. 

Selecting Next will continue with the configuration and show the Card/Badge Information page. 
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Card/Badge Information Page 

The card, badge, or USB drive number will be entered in the Enter Card/Badge ID number field.  

Select Back to change the configuration, select Next to continue, select Finish to accept the changes, or 
select Cancel to cancel changes. 

Manual Card/Badge ID Number Entry 
Although the easiest method for assigning a card or badge is automatic as described in the Automatic 
Card/Badge ID Number Entry section, ThinManager can be configured for manual entry 

If the Display “Create New User” dialog for unknown users check box on the Options window is 
unselected, the Enter Card/Badge ID number field will need to be entered manually. The Card/Badge ID 
number is accessible in the event log. To configure a terminal to allow a device one needs to: 

 Turn the Event Log on 

 Have the appropriate hardware on the terminal, either a USB port or a ProxCard reader. 

 Add the appropriate module. 

 Use the device once to have the device’s identifier entered to the event log. 

 Open the TermSecure User Configuration Wizard and enter the ID number to tie the TermSecure 
User to the device. 

 Login with the ID device. 
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Event Log 

The Event Log is configured in the ThinManager Server Configuration Wizard. 

Open the ThinManager Server Configuration Wizard by double clicking on the ThinManager Server icon in 
the tree, or highlighting it and selecting Edit > Modify from the menu. 

Navigate to the Historical Logging page. 

 

Historical Logging Page 

All events may be selected to be logged, but the Terminal Events checkbox is critical to the TermSecure 
Device detection. Select the Terminal Events checkbox and select the Finish button. 

USB Device Module 

When using the USB drive as a TermSecure identifier, the USB Flash Drive Module needs added to the 
terminal. 

See USB Flash Drive Module for details. 

ProxCard Reader Module 

A ProxCard Reader works much the same as the USB device, but uses a different module, the RF Ideas 
pcProx Module. 

See RF Ideas pcProx Module for details. 
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WaveTrend Tag Reader Module 

A WaveTrend Tag Reader works much the same as the USB device, but uses a different module, the 
WaveTrend Tag Reader Module. 

See Wavetrend Tag Reader for details. 

 

Device Identifier Number 

Next the ID device needs to be scanned or inserted to help find the ID number. 

Insert the USB device or scan the ProxCard on the terminal. 

A TermSecure message should be displayed. 

 

TermSecure Message 

The ID device will not work so the terminal will send a message with the ID device’s identifier number. 

 Record this number. 

This number is also entered in the event log if the Terminal Events were selected in the ThinManager Server 
Configuration Wizard. 

 Open ThinManager. 

 Highlight the terminal in the tree and select the Event Log tab. 

The ID for the device is entered in the log. 
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ThinManager Event Log 

Next the ID number needs to be associated with the TermSecure User. 

 Open the TermSecure User Configuration Wizard for the user you want to have 
use that ID device. 

 Navigate to the Card / Badge Information page. 
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Card / Badge Information Page 

 Select the This user will use a card, badge, or other device to log in checkbox. 

 Enter the ID Identifier from the earlier steps into the Enter Card/Badge ID number 
field. 

 Select the Always Prompt for Password, if desired. 

Now the Terminal is configured, the ID device is identified, and the TermSecure User is configured to use the 
device. 

 Insert the USB device into the USB port on the ThinManager Ready thin client or 
scan the ProxCard on the card scanner. 

The USB device will log the TermSecure User into the terminal server. 

 Open ThinManager. 

 Highlight the ThinManager Server and select the Event Log tab. 
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Event Log 

The Event Log will show the results of the successful login. The terminal will have the TermSecure User 
added to its icon in the tree, while the TermSecure User icon will show the name of the terminal that it is 
logged into. 




